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1 Scope 

1.1 Purpose of the Document 

This deliverable, but also D5.1 and D5.2, does not fully comply with the organization 

described in the Description of work, where we were thinking of slicing our tools 

according to the distinction among data, *ware, and process. While designing our 

tools, we understood that that division was unnatural, and would have led to 

conceivable overlapping among the different tools. Our tools are functionality-

specific, but they can easily work on the artefacts at the different levels of the 

hierarchy identified by the MOMOCS Description of Work. 

 This is why we opted for a different partitioning based on supplied features, instead 

of the abstraction level. In other words, we prefer to get rid of the horizontal layers 

originally proposed, and identify consistent and self-contained vertical segments that 

easily spread across data, *ware, and process. 

This document, in particular, describes how to install and use the XSM 

Transformation Tool whose aim is to help the modernization process proposed by 

[2007e] by means of specific transformation rules. 
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1.2 Document Structure 

The document is structured as follows: 

• Section 2, “Xsm Transformation Tool introduction” briefly explains the aim of 

XSM Transformation Tool  

• Section 3, “Transformation Tool getting started” is for installing instructions 

and a first use of the tool 

• Section 4, “Transformation Tool User’s Guide” depicts how to use the tool and 

which the core functionalities are 

• Section 5, “Troubleshooting”, mainly presents known issues and a FAQ 

section 

• Section 6, “Appendixes”, regards ongoing features and useful information that 

better detail some concepts described in the deliverable  

• Section 7, “Annexes” contains glossary and references 
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2 XSM Transformation Tool Introduction 

The XSM Transformation tool is in charge of aiding the evolution of a TBMS model 

into a MS model performed by following the Xirup methodology.  

It generally takes as an input: 

• A  XIRUP System Model (XSM) describing the To Be Modernised System 

(TBMS) or a partial modernized version of it 

• the XIRUP Metamodel, namely the reference metamodel [2007f] 

The output of the Transformation Tool will be: 

• a set of transformations applicable to the input XSM   

• An XSM which can be a fully or partially “Modernized System” (MS) model, 

according to the complexity of the modernization process and the way it is 

faced. 

 

The XSM Transformation tool (from here on called simply “TT”) is based upon the 

language and functionalities provided by the Eclipse M2M ATL project [ATL].  

Its main goal is encapsulating and improving those functionalities in order to 

transform TBMS models into suitable MS models which are compliant to user’s 

modernization requirements. 

For more references and documentation, please also refer to [ATL_DOC]. 
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3 Transformation Tool getting started 

This section aims at providing a brief introduction of TT and a step-by-step 

installation guide for all tools. 

3.1 Requirements 

The XSM Transformation Tool runs within Eclipse [Eclipse] and it requires the 

following software components: 

• Eclipse Modeling Framework plug-ins [EMF] 

• ATL plug-ins [ATL] 

At present, Windows 2000/XP is the reference OS and JRE 1.6 is suggested even 

though JRE 1.5 is supported as well.  

Figure 1  shows the TT architectural stack.   

 



Deliverable Number: D53 
Preparation Date: 30/11/2008

 

 

Document Version:1.0 

 
 

 
Project Number: IST-2006- 034466 
Project Start Date: 1st September, 2006 
Project Duration: 24 months 

DISSEMINATION LEVEL: PUBLIC 11 / 91 

 

 

Figure 1: XSM Transformation Tool stack 

 

3.2 Installation Guide 

This section will guide the user throughout the overall installation process, starting 

from retrieving the Eclipse platform to the execution of TT environment. 
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3.2.1 Eclipse and EMF installation 

The first step is installing both the Eclipse environment and the EMF framework. 

Eclipse is available at http://www.eclipse.org/downloads, release 3.3.1, which 

results from the Europa Project [Europa]. 

EMF can be downloaded at: 

http://www.eclipse.org/modeling/emf/downloads/?project=emf (version 2.3) 

which contains significant changes from previous releases. 

Installing the Eclipse environment is simply achieved by unzipping the 

corresponding archive; this will create a “\eclipse” directory containing all the 

Eclipse files required. At this stage, the EMF installation consists in unzipping the 

EMF archive into the same target directory. This last operation writes the set of EMF 

plug-ins in the “\eclipse\plugins” directory. Another way to get EMF plug-ins is 

using the Eclipse Update Manager which prevents the user from manually 

downloading and unzipping the required archives and, instead, allows installing all 

plug-ins only by just giving the right http address. 

Once the basic Eclipse bundle has been installed, the user can go to (Figure 2): 
  

 Help -> Software Updates -> Find and Install 
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Figure 2: Update Manager location 

 

and select the “Search for new features to install” radio button as displayed in Figure 3  
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Figure 3: New features to install 

 

By clicking on the “Next” button the user can now add a new remote site and get all 

the EMF required plug-ins. The right address is retrievable from EMF project web 

site at: 

http://www.eclipse.org/modeling/emf/updates   

Figure 4 shows this process. 
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Figure 4: Adding EMF remote site 

 
Subsequently, the user must select which kind of plug-ins he/she requires. Please be 

sure that the “Show the latest version of a feature” check box is selected. After that, 

navigate through the EMF feature tree and tick “EMF SDK 2.3.1” only (Figure 5) 
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Figure 5: Select EMF SDK feature 

 

By clicking the “Next” button, a licence agreement box is displayed and, after user’s 

acceptance, it leads to plug-in downloading and installation (Figure 6 and Figure 7).  
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Figure 6: User's acceptance 
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Figure 7: Final sum-up before installation 

 
Finally, the user is prompted to restart the whole application in order to let the 

changes take effect and have EMF correctly installed 

 

Figure 8: Restart Eclipse 



Deliverable Number: D53 
Preparation Date: 30/11/2008

 

 

Document Version:1.0 

 
 

 
Project Number: IST-2006- 034466 
Project Start Date: 1st September, 2006 
Project Duration: 24 months 

DISSEMINATION LEVEL: PUBLIC 19 / 91 

 

3.2.2 Installing ATL 

By following a similar process to the one depicted in the previous section, it is 

possible to install all the required plug-ins to get ATL correctly works. The simplest 

and most effective way to do that is once again by using the Update Manager. 

First of all, the right feature address must be retrieved from the ATL project web site 

(currently located at http://www.eclipse.org/m2m/atl/download) and a new 

remote site reference ought to be created in order to get all features (just call it 

“ATL”). Additionally, the already existing “Europa” remote site has to be selected to 

get and install some required plug-ins by ATL UML4ATL drivers (Figure 9). 

 

 

Figure 9: ATL installation 

http://download.eclipse.org/modeling/m2m/atl/updates/2.0.0 
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After ticking the ATL item and then clicking on the “Select required plug-ins” 

button, the Update Manager automatically selects all the bundles needed by ATL 

features.  

In addition, and following the same procedure, UML2 Tools, UML2 SDK and UML2 

Extender SDK [UML2Tools] features should be selected as well, since they provide 

functionalities to work on UML models: if missing plug-in errors appear, the user has 

just to load required bundles by pressing the related button. Figure 10, Figure 11 and 

Figure 12 show this process.   
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Figure 10: Select ATL features 
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Figure 11: Select ATL required plug-ins 
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Figure 12: Adding UML2 tools 

 
After installation, Eclipse should be restarted as usual. 

3.2.3 Installing XSM plug-ins 

The XSM feature contains primarily an Ecore [ECORE] version of the reference Xirup 

metamodel and provides a simple tree viewer to edit instances of that metamodel.  

Through the Update Manager it is possible to install the related plug-ins at 

https://services.txt.it/crs_subversioning/momocs/WP5/dev/polimi/momocs/. 

The current XSM version is 1.0.1 
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3.2.4 Installing XSM Transformation Tool plug-ins 

The TT plug-ins has been released as a zip file and they are downloadable from SVN 

at: 

https://services.txt.it/crs_subversioning/momocs/WP5/dev/txt/  

Plug-ins can be put into the Eclipse “\plugins” directory after unpacking the archive 

(version 1.0.1); they are situated in the “\bin” folder. There some additional folders 

containing source code, some resources (ATL example files), installation notes and a 

JavaDoc. An updateSite has also been created and it is situated under SVN, at: 

https://services.txt.it/crs_subversioning/momocs/WP5/dev/txt/update/xsmtrans

formationtool/ 

These are the names of each plug-in: 

• org.momocs.txt.transformation.cheatsheet 

• org.momocs.txt.transformation.atleding 

• org.momocs.txt.transformation.atl4xirup 

• org.momocs.txt.transformation.xiruptransformationphelp 

 

At this point, Eclipse is ready to be re-started in order to let all changes take effect. 

3.3 Getting Started 

Launch Eclipse by double-clicking on the proper icon  and select the right 

perspective: TT extends the existing ATL perspective by means of specific views, 

menu and wizards. In the Eclipse Platform a perspective determines the visible 

actions and views within a window.  Perspectives also go well beyond this by 

providing mechanisms for task oriented interaction with resources in the Eclipse 
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Platform, multi-tasking and information filtering [Eclipse_ref] 

 

 

 

 

Figure 13: Select proper perspective 
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Figure 14: TT workbench 

 

Five major areas are displayed: 

• Navigator – for workspace browsing 

• ATL operations view – for easy use and browsing of ATL functions while 

editing transformations 

• Editor area – for writing, editing and creating transformation rules 

Navigator  
 

Ready-to-
use  
operations

Common 
views area 

Editor area 
 

Outline  
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• Common views area – see resource properties, problems occured, error logs 

and stack traces 

• Outline – shows an outline of the structural elements of the editor   

 
To get an idea of how TT works, which kind of resources it handles and the main 

common steps a user performs while running a transformation, a first interactive 

tutorial has been developed. 

Eclipse provides a built-in mechanism for displaying mini-tutorials called cheat sheets. 

Cheat sheets are quick-and-dirty instructions showing how to perform multi-step 

processes and they are displayed on the side of the workbench where users can 

quickly and easily step through them. Available cheat sheets are displayed by 

clicking on: 

• Help > Cheat Sheets  or 

• Window > Show View > Other > Cheat Sheets > Cheat Sheets > OK. 

Cheat sheets appear as a view on the right side of the workbench, making it easy to 

simultaneously read and execute the cheat sheet instructions. 
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Figure 15: Selecting the cheat-sheet (1) 
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Figure 16: Selecting the cheat-sheet(2) 

 

A first MOMOCS cheat sheet has been created to help the user start with 

transformations.  

In the case of “MOMOCS first transformation”, the user is guided through the 

process of creating and importing a set of resources (a project, a transformation, 

input/output models and the Xirup metamodel) by means of simple instructions 

combined with automatic actions. 
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Figure 17: TT cheat-sheet 

 

Due to the high number of interactions and resources involved while using 

transformations, we believe that this kind of approach, based on heavy user-

interactions, can be useful to take a first look of TT. 

 

Follow the instructions of 
each step by clicking on 
the proper link 
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4 Transformation Tool User’s Guide 

As depicted in section 2, TT is based upon the set of plug-ins provided by [ATL]. 

Thus, compiling and executing functionalities are managed by ATL tools while TT is 

mainly intended to help the user use them and to encapsulate them within the 

concepts that Xirup promotes. 

As a consequence, the purpose of this deliverable is not describing the ATL language: 

the related documentation can be found at [ATL_DOC].  

For instance, TT extends ATL editing features and provides the user with facilities to 

get in touch with transformations.  

Most importantly, TT has another primary goal to cope with:  it actually strives to 

“bridge” the Xirup methodology and its related metamodel to the ATL concept of 

model transformation. 

In few words, TT is the tool that allows end-users to use ATL for Xirup, placing 

itself exactly “inside” the methodology (see “ATL4XIRUP Library” section for 

details).  

For this reason, one of the most important results is the generation of core TT-

embedded ATL transformations for Xirup aiming at giving to every MOMOCS user 

is going to face model transformations, a set of solid basis to start with. This idea will 

be better explained in section 4.7 

The TT is mainly composed of four components: 

• CheatSheet: it provides quick tutorials for highly interacting get-started 

facilities 

• ATLEditing: editing functionalities extending ATL  



Deliverable Number: D53 
Preparation Date: 30/11/2008

 

 

Document Version:1.0 

 
 

 
Project Number: IST-2006- 034466 
Project Start Date: 1st September, 2006 
Project Duration: 24 months 

DISSEMINATION LEVEL: PUBLIC 32 / 91 

 

• ATL4Xirup library: provides ready-to-use base Xirup ATL transformations, 

related resources and user-interfaces to really speed up the use of 

transformations within the Xirup methodology 

• XirupTransformationHelp: help contents  

 

Each bullet above will be described in more detail throughout the current 

deliverable. 

Next sections describe common actions and TT enhancing features. 

 

In addition to this User’s Manual, screencasts are available at: 

https://services.txt.it/crs_subversioning/momocs/WP5/dev/txt/screencast/ 

They describe TT functionalities by means of videos focusing on common activities.  
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4.1 Setting up a new project 

The user can create a new ATL project by selecting File->New->ATL Project and 

using the related wizard. 

 

 

 

Figure 18: Selecting wizard to create a new ATL project 
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Figure 19: Setting up the name 

 

 

Figure 20: Project in the Navigator view  

 

After that, the Navigator view will display the project just created which will act as a 

transformation container during the modernization process. 
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4.2 Initializing a transformation 

A new transformation is created and initialized by using the ATL file wizard 

accessible through File->New->ATL File. 

Figure 21 shows the wizard to create a new ATL transformation: most important 

fields to be filled in are the name of the transformation itself (here called “Module”) 

and input/output metamodel/model labels which are used to access source and 

target model elements during the editing process.  

 

 

Figure 21: New ATL File wizard 

 

 
Figure 22 shows instead a module creation example. 
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Figure 22: ATL File creation 

 
Basic fields to be filled in are: 

1. name of the transformation 

2. type of transformation 

4 

6 

3 

5 

1 
2 
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3. label to identify input model within the transformation 

4. label to identify input metamodel within the transformation 

5. label to identify output model within the transformation 

6. label to identify output metamodel within the transformation 

 

After inserting the desired labels to identify model elements within the ATL module, 

the user can press the “Finish” button to trigger the creation of the related ATL file 

(Figure 23 below). 

 

 

Figure 23: Transformation header 
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The header shown in the picture above states that: “this module ‘Billing2JBilling’ 

creates a target model labelled ‘OUT’ from a source model labelled IN”. Under this 

header, declarative and imperative ATL instructions (see [ATL_DOC] for references 

and documentation) must be inserted in order to explicitly declare all rules 

performing the mappings and allowing to get the desired output model from an 

input model.   

4.3 Editing 

Despite ATL is a powerful tool and, in addition, it’s published together with a good 

documentation [ATL_DOC], it is not as user-friendly as a new MOMOCS user could 

desire.  

Textual editing for writing proper rules can be not much intuitive and continuous 

references to documentation and manuals for using the right syntax could slow the 

modernization process. 

Figure 24 shows an example. 
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Figure 24: Common editing activity 

 

Therefore, as long as we have been coping with ATL transformations and editing 

activities, we took notes about possible editing improvements for helping end-users 

master and manage transformations.  

Next subsections will describe TT editing features extending and enhancing current 

editing functionalities. 

These features represent a first contribution towards a “friendlier” editing support.  

4.3.1 Adding ATL expression  

TT improves the “ATL Editor” with ready-to-use templates in order to use the main 

language constructs.  

These constructs are the following (please see [ATL_DOC] for references): 

Example of rule and 
helper editing  
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• Helper 

• Matched rule  

• Light Matched rule – reduced pattern with the most used keywords only 

(chosen according to our experience) 

• Called rule  

• Light Called rule – see “Light Matched rule” 

• Imperative expressions: 

o If 

o For 

• OCL [OCL] declarative expressions: 

o If 

o Let 

 

Figure 25 shows a screenshot of this extended menu. 
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Figure 25: ATLEditing menu 

 
They can be easily inserted thanks to menu actions to which also key-binding 

features are associated. This way, users (especially the first times they’re using ATL 

transformation) don’t have to keep on checking manuals and documentation to get 

references for right syntax. 

 

Figure 26 in the next page shows an example of inserting a “Called Rule Pattern” 

block by clicking on the proper menu item, while Figure 27 displays a “Matched Rule 

Pattern” insertion obtained, instead, by means of key-binding. 
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Figure 26 - Insert Called rule pattern 
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Figure 27: Insert matched rule pattern 

 

After inserting the desired pattern, the user can then modify it and customize it 

(Figure 28). 

 

 

User pressed Ctrl+Shift+M 
combination 
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Figure 28: Customizing pattern 

 

 

4.3.2 Tree structured view for ATL operations 

Apart from general constructs used to express both declarative and imperative 

instructions (as discussed in the previous section), the ATL language also provides a  

set of both OCL-derived and characteristic operations.  

They are organized as follows: 

• OclAny operations 

• Boolean Data Type operations 

• String Data Type operations 

• Numerical Data Type operations 

• Operations on collections 
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• Sequence Data Type operations 

• Set Data Type operations 

• OrderedSet Data Type operations 

• Bag Data Type operations (defined by OCL specification but not still available 

with current ATL implementation) 

 

It’s not however in the scope of this document explaining the meaning and the use of 

these operations, but instead showing how TT aids the user to manage them. 

TT provides a tree-structured Eclipse view showing all main ATL operations 

organized according to the separation presented in the bullets above.  

Each item is associated to a tip describing the item itself and thus giving information 

about the operation it represents: user’s double-click will trigger the insertion of the 

correct operation syntax into the ATL file which is actually in editing mode. This 

view can be thus considered an “active” manual reference provided by TT to make 

the process of creating and editing transformations much faster.  
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Figure 29: ATL operations Tree viewer (1) 
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Figure 30: ATL operations Tree viewer (2) 

 
Thus, the user can browse the operations organized in categories and select the one 

it’s most suitable for the current task (Figure 31).   
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Figure 31: Browse operations and select 

 

By double-clicking on the selected item, the related operation pattern is inserted into 

the transformation currently in editing mode (Figure 32) 

Browse 
Missing operation 
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Figure 32: Double-click on operation 

 
And finally the user can modify it according to actual needs (Figure 33) 

 

Figure 33: Operation customized by the user 

 

Pattern inserted 

Customization 
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4.4 Saving 

Every time a transformation is saved, the ATL Builder dumps ATL Virtual Machine 

instructions to a *.asm file which is then executed when running the transformation 

itself.  

 

 

Figure 34: Dumping ASM 

 

If dumping has no success, the Console shows all errors occurred and why new ATL 

Virtual Machine instructions have not been generated (Figure 35).  

It must be highlighted that at present, ASM files can be automatically created only if  

corresponding ATL files are stored inside ATL projects. 

 

 

Figure 35: Errors occured 

This is the *.asm file but it still 
associated with the last correct 
version of “Billing2JBilling.atl” 
since one syntax error occurred here 
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4.5 Commenting a transformation 

Since it could be useful adding some extra information to each ATL file that has been 

created and edited, a user can add personal comments by means of a special property 

page. The content he/she writes is then attached in a persistent way to the file itself. 

  

 

Figure 36: Accessing to file properties 
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A property page is thus displayed and the user can comment the transformation to 

better identify its contents. 

 

 

Figure 37: Commenting transformation file 

4.6 Running 

In order to start the execution of a transformation the user has to set and launch an 

ATL launch configuration which represents the actual way to prepare and glue 

together all the resources involved in the execution of the transformation itself. 

By clicking on Run->Open Run Dialog a Run box appears showing different 

types of editable launch configurations (Figure 38). 
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Figure 38: Run dialog 

  

By double-clicking on “ATL Transformation”, a launch configuration edit panel 

shows: here all resources can be loaded and running parameters can be properly 

configured. 

First of all, a transformation container (ATL project) and a transformation file have to 

be chosen.  

This way, by reading metamodel and model labels contained into the transformation 

file, ATL knows how many metamodels and models have to be loaded. Figure 39: 

Loading  shows an example of this procedure. 
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Figure 39: Loading parameters 

 
The “Billing2JBilling” transformation is a Xirup2Xirup transformation, thus it 

requires only one metamodel to be loaded, and it takes one model as input in order 

to generate one output model.  

In case, for example, of an UML2Xirup transformation (thus working with two 

metamodels, namely UML and Xirup), the launch configuration dialog box will 

prompt two metamodel input edit boxes as displayed in Figure 40: load UML2Xirup 

transformation. 

 

Edit fields 
generated 
automatically  
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Figure 40: load UML2Xirup transformation 

 
Metamodels can be loaded from workspace, file system or from EMF Registry (see 

yellow highlighted buttons) provided that they have been previously registered in 

the EMF registry itself. Usually, metamodels are serialized and stored as Ecore files 

[ECORE].   

4.7 ATLforXirup Library 

This sections depicts the work done to bridge Xirup concepts (intended as 

methodology and metamodel) and ATL. 

Edit fields 
generated 
automatically  
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4.7.1 Xirup2Xirup 

At present, more than one ATL technique exists in order to transform a source model 

into a target model and, additionally, two ATL compilers can be used to perform a 

transformation (see [ATL_DOC] for references): this means different possibilities 

with different pros and cons to pursue the same task.  

That said, TT must give to users the chance to choose among these several 

possibilities and select the best solution that suit to a particular scenario. 

Basically, when creating and defining a transformation, a user can proceed in two 

ways: 

1. declare each rule so that the ATL engine allocates only those model elements 

that are explicitly mapped by a rule (default mode) 

2. refine a model so that the ATL lets the developer map only model elements 

he/she is interested in and automatically allocates all other elements that have 

not been  explicitly managed by user rules (refining mode) 

According to scenarios, (1) or (2) can result more suitable each other.  

It should be clear that with (1), the developer has a full control over the whole 

transformation process, thus he/she must explicitly manage every model element in 

order to keep the source model consistent with the target model: not doing that 

would mean generating only those elements that have been specified in user rules, 

with an evident loss of information.  

This leads to the concept of “Copy transformation”: a copy transformation explicitly 

manages, thus generates, all model elements and permits the user to focus only on 

those that have to be changed for modernization purposes (this is strictly correlated 

to the so called technique “superimposition” [ATL_DOC]). 
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On the other side, (2) implements a similar approach as (1) but in an automatic way 

since the ATL engine does the “copy” in place of the user. Note that, due to current 

execution semantics of the refining mode, some specific precautions still have to be 

taken by developers. It may be required, for example, when designing an ATL 

module in refining mode, to specify additional explicit rules in order to make sure 

that all source model elements are transformed into their corresponding target 

model elements.  

However, it’s not the purpose of this section describing the different ATL execution 

modes, for further information please refer to [ATL_DOC] or “Annexes: ATL 

Execution modes” 

The brief description above, aims instead at letting the reader understand that, 

according to the scenario, type of elements to be managed and user preferences, (1) 

and (2) can be preferred to each other. If (2) could be easily managed by developers 

but it’s not flexible, (1) should require a Xirup copy transformation to be defined, but 

it warranties a complete control over the transformation process. 

Giving the amount of Xirup metamodel elements, the work done for TT also includes 

that copy transformation, preventing end-users from defining it by themselves.  

Additionally, the ATL2006 compiler introduces new functionalities (such as rule 

extension mechanism) but it still doesn’t support some features, for example the 

refining mode itself. 

As a consequence, two Xirup copy transformations have been defined: one for 

ATL2004 compiler and one for ATL2006 compiler. 

These two transformations are embedded in TT and can be always retrieved by 

means of proper wizards. They can be accessed by selecting File->New-

>XirupCopy 2004/2006 or File->New->Other->ATL4Xirup category. 
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Figure 41: Get access to XirupCopy wizards (1) 

 

 

Figure 42: Get access to XirupCopy wizards (2) 
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The wizard allows the user to set a new ATL project, automatically get a XirupCopy 

transformation and optionally:  

• importing an existing Xirup model 

• importing the Xirup metamodel ecore file 

• generating an ATL launch configuration stub 

 

 

Figure 43: XirupCopy 2004 (for ATL compiler 2004) wizard 
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What Figure 44 displays is the Navigator View after all the resources have been 

created/imported into the proper ATL project. 

 

 

Figure 44: Navigator view 

 
The following table gives a brief explanation of these resources. 
 
Icon Name Type 

 _xirupCopy.launch ATL launch configuration stub generated 

automatically by TT to run the transformation 

(the name of this file derives from the name of the  

containing project) 

 billing_model.xsm Input XSM to be modernized that has been 
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imported 

 momocs.ecore Xirup metamodel file 

 XirupCopy2004.asm Execution file generated automatically. Users do 

not have to worry about this file 

 XirupCopy2004.atl ATL transformation file containing  all rules to 

copy source elements to target elements 

 

Table 1: Resources created after using XirupCopy2004 wizard 

 
XirupCopy2004 transformation consists of more than forty rules intended to copy 

all the information from source to target models: at this point, the user can directly 

modify that transformation by creating, deleting and changing rules of his/her 

interest in order to generate a (partly or fully) modernized output model without 

worrying about the rest, namely model elements that must be kept unchanged. 

If the result is satisfactory, the modified XirupCopy transformation (actually no more 

a “XirupCopy”) can be stored to the KB Repository: whenever the user will need a 

new XirupCopy transformation, a new wizard can be used. 

In addition to a direct modification, a new transformation can be created (see section 

4.2) and “superimposed” to the XirupCopy transformation. 

Superimposition means that “while ATL transformation modules and queries are 

normally run by themselves, that is one transformation module or query at a time, it 

is also possible to superimpose several transformation modules on top of each other. 

The end result is a transformation module that contains the union of all 

transformation rules and all helpers, where it is possible for a transformation module 
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to override rules and helpers from the transformation modules underneath” 

[ATL_DOC]. 

Screencasts on these features have been provided and are available under SVN (see 

beginning of section 4 for references). 

Resuming, the aim of XirupCopy and related wizards is having a ready-to-use tool 

for Xirup2Xirup modernization, allowing the user to focus only on the actual, real 

target of the modernization itself and not wasting time for out of scope activities. 

After having imported the resources presented in Table 1, creating and modifying 

transformations according to his\her current needs, the user can run the 

transformation basing upon the launch configuration stub generated automatically 

by the wizard. 

 

Figure 45: Launch configuration stub 

 

XirupCopy 2006 wizard provides the same functionalities as XirupCopy 2004 one, 

but the embedded copy transformation is written to be executed with ATL compiler 

2006. 

Some parameters are already 
set to speed up the process, 
but of course the user can 
change and modify them  
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For more information about core differences between those two approaches, please 

see section 6.3 or [ATL_DOC]. 

4.7.2 UML2Xirup and Xirup2UML 

Similarly to what presented in section 4.7.1, UML2Xirup and Xirup2UML wizards 

aim at giving help in getting Xirup models from UML models and vice versa. 

The current supported UML format is EMF serializable, namely the same format 

which UML models created with Eclipse UML2Tools [UML2Tools] are based on. 

The aim of these wizards is creating and importing a set of resources, first of all 

proper transformations, in order to let the user switch from UML models to Xirup 

models and vice versa. 

Figure 46: shows the UML2Xirup wizard: the only difference from the one described 

in the previous section regards the possibility to import the UML metamodel file 

which is needed to run the converting transformation (thus UML2Xirup or 

Xirup2UML). 
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Figure 46: UML2Xirup wizard 

 
After filling in all the fields of interest (the only mandatory one is project name), a set 

of resources are created, similarly to what happened for XirupCopy. 

Figure 47: shows the Navigator view after using the wizard. 
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Figure 47: Navigator view 

 
The following table gives a brief explanation of resources above. 
 

Icon Name Type 

 _UML2Xirup.launch ATL launch configuration stub generated 

automatically by TT to run the transformation 

(the name of this file derives from the name of the  

containing project) 

 uml_input.uml Input UML model to be converted into a TBMS 

XSM 

 momocs.ecore Xirup metamodel file 

 UML.ecore UML metamodel file 
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 UML2Xirup.asm Execution file generated automatically. Users do 

not have to worry about this file 

 UML2Xirup.atl ATL transformation file containing  rules to get a 

XSM from a UML model 

 

Table 2: Resources created after using UML2Xirup wizard 

 

We do not present the Xirup2UML wizard since it’s based on the same concepts that 

have already been depicted throughout this section. 

It’s mandatory mentioning that actual UML2Xirup and Xirup2UML transformations 

are not complete, but they are instead initial examples giving a first idea of what is 

going to be provided for sure in future: a set of tools to quickly switch from UML 

and Xirup. 

Along with XirupCopy wizards, these functionalities are intended to cover the 

following process: 

 

Figure 48: From UML to Xirup and back again 
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4.8 Help facilities guidelines 

In addition to editing facilities and transformations from and to Xirup, TT intends to 

supply a general support to correctly use the tool.  

Thus, we want to provide learning instruments such as: 

• Help contents 

• Cheat sheets 

Hep contents are going to be filled in while collecting end-users’ feedback in order to 

build a meaningful documentation (screenshot available in Figure 49).  

 

 

Figure 49: Xirup transformation help contents 

  

A first cheat sheet, instead, has already been developed (see section 3.3).  
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Future cheat sheets can be developed according to actual user needs that come from 

testing and evaluation of TT. 

Possible tutorial can concern, for instance, explanation of superimposition and 

refining techniques. 
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5 Troubleshooting  

5.1 Known issues 

5.1.1 EJavaClass type error 

As far as we could see, ATL is not able to generate those target elements having a 

type which is related to non-primitive Java types such as Boolean, Float, etc. and 

java.lang.String. This issue may be better explained through an example. 

Let’s consider a JavaType element deriving from java.io.File and a TagType 

element with the following properties: 

• Id = “40” 

• Name = “Source Location” 

• Type = JavaType java.io.File 

The screenshot in the next page shows this example: 
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Figure 50: TagType element properties 

 

We have also a Tag element having these properties: 

• Id = “45” 

• Name = “Instance” 

• Type = TagType Source Location 

• Value = ACED000574000F69732069742072756E6E696E673F3F [This is due to 

EMF serialization, the model is actually generated by code] 
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Figure 51: Tag element properties 

 

If we try to allocate the “Value” field of Tag (shown in the picture above) by means of 

any ATL transformation (tests have been done with XirupCopy transformations) the 

ATL Virtual machine return the following error: 

 

GRAVE: ****** BEGIN Stack Trace 

GRAVE:  message: ERROR: cannot convert d:\Login.java : class java.io.File from EMF. 
GRAVE: A.main() : ??#24 null 
GRAVE:  local variables = {self=XIRUPCopy2004 : ASMModule} 
GRAVE:  local stack = [] 
GRAVE: A.__exec__() : ??#78 null 
GRAVE:  local variables = {e=TransientLink {rule = 'Tag', sourceElements = {s = IN!Login.java}, 
targetElements = {t = OUT!Login.java}, variables = {}}, self=XIRUPCopy2004 : ASMModule} 
GRAVE:  local stack = [] 
GRAVE: A.__applyTag(1 : NTransientLink;) : ??#64 129:15-129:22 
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GRAVE:  local variables = {t=OUT!Login.java, s=IN!Login.java, link=TransientLink {rule = 'Tag', 
sourceElements = {s = IN!Login.java}, targetElements = {t = OUT!Login.java}, variables = {}}, 
self=XIRUPCopy2004 : ASMModule} 
GRAVE:  local stack = [OUT!Login.java] 
GRAVE: ****** END Stack Trace 
INFO: Execution terminated due to error (see launch configuration to allow continuation after errors). 
GRAVE: ERROR: cannot convert d:\Login.java : class java.io.File from EMF. 
java.lang.RuntimeException: ERROR: cannot convert d:\Login.java : class java.io.File from EMF. 
 at org.eclipse.m2m.atl.engine.vm.SimpleDebugger.error(SimpleDebugger.java:185) 
 at org.eclipse.m2m.atl.engine.vm.StackFrame.printStackTrace(StackFrame.java:85) 
 at org.eclipse.m2m.atl.engine.vm.StackFrame.printStackTrace(StackFrame.java:81) 
 at 
org.eclipse.m2m.atl.drivers.emf4atl.ASMEMFModelElement.emf2ASM(ASMEMFModelElement.java:186) 
 at org.eclipse.m2m.atl.drivers.emf4atl.ASMEMFModelElement.get(ASMEMFModelElement.java:134) 
 at org.eclipse.m2m.atl.engine.vm.ASMOperation.realExec(ASMOperation.java:288) 
 at org.eclipse.m2m.atl.engine.vm.ASMOperation.exec(ASMOperation.java:161) 
 at org.eclipse.m2m.atl.engine.vm.nativelib.ASMOclAny.invoke(ASMOclAny.java:133) 
 at org.eclipse.m2m.atl.engine.vm.nativelib.ASMOclAny.invoke(ASMOclAny.java:91) 
 at org.eclipse.m2m.atl.engine.vm.ASMOperation.realExec(ASMOperation.java:230) 
 at org.eclipse.m2m.atl.engine.vm.ASMOperation.realExec(ASMOperation.java:325) 
 at org.eclipse.m2m.atl.engine.vm.ASMOperation.exec(ASMOperation.java:161) 
 at org.eclipse.m2m.atl.engine.vm.nativelib.ASMOclAny.invoke(ASMOclAny.java:133) 
 at org.eclipse.m2m.atl.engine.vm.nativelib.ASMOclAny.invoke(ASMOclAny.java:91) 
 at org.eclipse.m2m.atl.engine.vm.ASMOperation.realExec(ASMOperation.java:230) 
 at org.eclipse.m2m.atl.engine.vm.ASMOperation.exec(ASMOperation.java:161) 
 at org.eclipse.m2m.atl.engine.vm.ASMInterpreter.<init>(ASMInterpreter.java:289) 
 at org.eclipse.m2m.atl.engine.AtlLauncher.launch(AtlLauncher.java:155) 
 at org.eclipse.m2m.atl.engine.AtlLauncher.launch(AtlLauncher.java:105) 
 at org.eclipse.m2m.atl.engine.AtlLauncher.launch(AtlLauncher.java:81) 
 at org.eclipse.m2m.atl.adt.launching.AtlRegularVM.runAtlLauncher(AtlRegularVM.java:351) 
 at org.eclipse.m2m.atl.adt.launching.AtlRegularVM.runAtlLauncher(AtlRegularVM.java:453) 
 at org.eclipse.m2m.atl.adt.launching.AtlRegularVM.launch(AtlRegularVM.java:425) 
 at 
org.eclipse.m2m.atl.adt.launching.AtlLaunchConfigurationDelegate.launch(AtlLaunchConfigurationDelegate.java:
35) 
 at org.eclipse.debug.internal.core.LaunchConfiguration.launch(LaunchConfiguration.java:766) 
 at org.eclipse.debug.internal.core.LaunchConfiguration.launch(LaunchConfiguration.java:608) 
 at org.eclipse.debug.internal.ui.DebugUIPlugin.buildAndLaunch(DebugUIPlugin.java:899) 
 at org.eclipse.debug.internal.ui.DebugUIPlugin$7.run(DebugUIPlugin.java:1102) 
 at org.eclipse.core.internal.jobs.Worker.run(Worker.java:55) 

 

We suppose this is due to the fact that ATL has not been designed to manage 

complex Java types as java.io.File and similar. 

At present, we ignore values coming from those kind of types and we take into 

account only simple Java types. 

Within the TT implementation activities we have planned to investigate on this issue 

in order to find a more structured solution. 
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5.2 Bug Reporting 

Please use the project Bugzilla for bug reporting at 

'http://demos.txt.it/momocs_bugzilla’ 

. 

5.3 FAQ 

 

Q: Do users have to write ATL rules on their own in order to modernize Xirup 

models? 

A: TT simplifies the editing process providing a set of facilities such as syntax 

templates and the operations view; however, users still have to write ATL rules or,  

at least , there should be a person managing TT and creating proper transformations 

to be stored in the KB and reused by all other MOMOCS users. 

However, we’re going to build a set of “transformation patterns” and related user- 

interfaces to provide parametic transformations that target common modernization 

issues. 

 

Q: How can I customize ongoing parametic transformations? 

A: Xirup metamodel provides a tagging mechanism: by using tags, model elements 

can be identified and updated according to the rules specified in the transformation. 

 

Q: Why are XirupCopy, UML2Xirup and Xirup2UML transformations TT-embedded 

instead of being simply stored into the KB? 
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A: We can say that they are some kind of “rail lines” addressing and covering the 

major steps of the Xirup modernization process.   

They are the actual foundations which transformations that really perform the 

modernization and effectively need to be stored into the KB can be based upon.  
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6 Appendixes   

6.1 Ongoing features 

Several ongoing features are planned to be implemented from the next TT release. 

Below, a list of bullets shows the major ones. 

• Editing facilities improving with little graphical support 

• Creation of further cheat-sheets covering major learning issues (e.g. ATL  

superimposition and refining techniques, but this also depends on end-users 

needs and evaluation) 

• Help contents documentation filling 

• Creation of transformation patterns and related user interfaces 

 

6.2 ATL Execution modes 

From [ATL_DOC]: 

Default execution mode: 

The execution of an ATL module is organized into three successive phases: a module 

initialization phase, a matching phase of the source model elements, and a target 

model elements initialization phase. 
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The module initialization step corresponds to the first phase of the execution of an 

ATL module. In this phase, the attributes defined in the context of the transformation 

module are initialized. Note that the initialization of these module attributes may 

make use of attributes that are defined in the context of source model elements. This 

implies these new attributes to be also initialized during the module initialization 

phase. 

During the source model elements matching phase, the matching condition of the 

declared matched rules are tested with the model elements of the module source 

models. When the matching condition of a matched rule is fulfilled, the ATL engine 

allocates the set of target model elements that correspond to the target pattern 

elements declared in the rule. Note that, at this stage, the target model elements are 

simply allocated: they are initialized during the target model elements initialization 

phase. The last phase of the execution of an ATL module corresponds to the 

initialization of the target model elements that have been generated during the 

previous step. At this stage, each allocated target model element is initialized by 

executing the code of the bindings that are associated with the target pattern element 

the element comes from. The imperative code section that can be specified in the 

scope of a matched rule is executed once the rule initialization step has completed. 

This imperative code can trigger the execution of some of the called rules that have 

been defined in the scope of the ATL module 

 

Refining execution mode: 

The refining execution mode introduces specific semantics for the implicit generation 

of copied model elements.  
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An ATL module executed in refining mode follows the three successive phases of the 

default execution mode. The execution of the first phase, the module initialization 

phase, remains unchanged compared to the default execution mode. During the 

source model elements matching phase, the ATL engine only evaluates the matching 

conditions of the explicitly specified matched rules. This implies that, at this stage, 

the only target model elements that are allocated are those that are generated by 

these explicit transformations rules.  

The differences with the default execution mode appear during the execution of the 

initialization phase of the target model elements. In refining mode, this phase has to 

deal with the initialization of the explicitly generated target model elements, but also 

with the allocation and the initialization of the target model elements that are 

implicitly generated.  

For this purpose, each time an already allocated target model element is initialized 

with a reference to a non-allocated model element, the ATL engine allocates and 

initializes this new target model element. If the newly created model element also 

refers to another non-allocated model element, this process is repeated recursively.  

Note that with the described semantics, no target model element will be generated 

for a source model element that is neither matched by an explicit rule, nor referred, 

directly or indirectly, by an explicitly generated target model element  

6.3 XirupCopy transformations 

This section provides some screenshots and examples showing the main 

characteristics of the two XirupCopy transformations that have been created and 

supplied along with TT.  
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The concept which they lay on is the same, but they are defined for two different 

compilers, ATL 2004 and ATL 2006.  

Section 6.3.3 also gives an example of porting activities for XirupCopy 2004 with 

different Xirup metamodel releases. 

6.3.1 XirupCopy2004 

XirupCopy2004 is explicitly defined to be executed by ATL compiler 2004 and, as 

already described, copies all elements from the source model to the target model. 

In the next page, some indicative screenshots are displayed. 
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Figure 52: XirupCopy2004 (1) 
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Figure 53: XirupCopy2004 (2) 
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6.3.2 XirupCopy2006 

This transformation performs the same mappings as XirupCopy2004, but it’s 

designed to exploit an interesting new ATL2006 feature, called “rule inheritance”. 

This approach was followed since it gives a more coherent vision of the 

transformation if we take into account the metamodel structure. For example, it 

avoids re-mapping elements once they have been already matched by a parent rule. 

A small example is shown below: 

 

abstract rule BasicElement{ 

 from 

  s : Xirup!BasicElement 

 to 

  t : Xirup!BasicElement( 

   id <- s.id, 

   tag <- s.tag, 

   metric <- s.metric 

 )   

} 

rule Model extends BasicElement{ 

 from 

  s: Xirup!Model 

 to 

  t: Xirup!Model( 

   name <- s.name, 

   description <- s.description, 

   element <- s.element,  

   tagtype <-s.tagtype    
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  ) 

} 

rule Method extends BasicElement {  

 from  

  s : Xirup!Method 

 to 

  t : Xirup!Method ( 

   name <- s.name 

 ) 

} 

 

Of course Method class extends BasicElement class, that’s why the rule inheritance 

works. It’s clear that this approach easily lead to an elegant and straightforward way 

to express the mappings. 

With ATL2004 Compiler, the three rules above would be: 

 

rule Model { 

 from 

  s: Xirup!Model 

 to 

  t: Xirup!Model( 

   id <- s.id, 

   tag <- s.tag, 

   metric <- s.metric, 

   name <- s.name, 

   description <- s.description, 

   element <- s.element,  
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   tagtype <-s.tagtype    

  ) 

} 

 

rule Method{  

 from  

  s : Xirup!Method 

 to 

  t : Xirup!Method ( 

   id <- s.id, 

   tag <- s.tag, 

   metric <- s.metric, 

   name <- s.name 

 ) 

} 

 

As it’s clearly observable, the mappings expressed in bold character (coming from 

the abstract BasicElement) must be explicitly allocated in each rule that manage all 

BasicElement child elements (in this example Method, Model). 

Abstract rules defined within XirupCopy2006 are:  

• BasicElement 

• Type 

• Relation 

• InternalElement 

• Element 

• Instance 

• AbstractConstraint 
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• ConstraintParameter 

• InfoInstance 

• InfoType 

• AbstractActitivy 

 

Next pages show some useful screenshots. 
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Figure 54: XirupCopy2006 (1) 
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Figure 55: XirupCopy2006 (2) 

 

6.3.3 Work case example 

This section let the user have a look of some screenshots taken from a real 

transformation work case, the one that has been done to port the XirupCopy2004 

transformation with the Xirup model version 0.0.1 to the XirupCopy2004 

transformation with the Xirup model version 1.0.0. 
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ComponentTypeAggregation now extends ComponentType: 

Features name, library, requires, offers, infortype, attributetype, externalModelReference 

and behaviour added to “ComponentTypeAggregation” rule due to inheritance from 

ComponentType. Moreover, subcomponents field has been added. 

No more ComponentType.parts in “ComponentType” rule. 

 

 

Figure 56: Old XirupCopy2004 

 

Deleted 
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Figure 57: New XirupCopy2004  

 

 

 

Inserted (red box) 
and deleted (blue 
box) features
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ComponentInstance is changed: 

subcomponents and supercomponent features instead of parts 

 

 

 

Figure 58: Another example of porting XirupCopy transformation 

Deleted 

Inserted  
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7 Annexes 

7.1 Acronyms and Glossary 

 

Acronym Meaning 
XIRUP eXtreme end-User dRiven Process 
XSM XIRUP system model 
TBMS To be modernised system 
MS Modernised system 
UML Unified modelling language 
UC Use case 
OCL Object constraint language 
KB Knowledge base 
EMF Eclipse modelling framework 
ATL Atlas Transformation Language 
TT XSM Transformation Tool 
RCP Rich Client Platform 

 

7.2 Reference Documents 

 

[2007a] MOMOCS team, D11  XIRUP Methodology Requirements 

[2007b] MOMOCS team, D12 Methodology Requirement Analysis Report: industrial 

solution and Telecommunications Cases 
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[2007c] MOMOCS team, D13 State of the art analysis on Actual Mainstream 

Methodologies 

[2007d] MOMOCS team, D21 XIRUP Supporting  tools Requirements 

[2007e] MOMOCS team, D31 XIRUP Methodology Specifications 

[2007f] MOMOCS team, D41 XIRUP Supporting Tools Specifications 

[ATL] ATLAS Group (INRIA & LINA), “ATL Project” http://www.sciences.univ-

nantes.fr/lina/atl/ and http://www.eclipse.org/m2m/atl/ 

[ATL_DOC] ATL Documentation: 

http://www.eclipse.org/m2m/atl/doc/ 

http://www.eclipse.org/m2m/atl/doc/ATL_Starter_Guide.pdf 

http://www.eclipse.org/m2m/atl/doc/ATL_User_Manual%5Bv0.7%5D.pdf 

http://wiki.eclipse.org/ATL_Superimposition 

http://www.eclipse.org/m2m/atl/atlTransformations/ 

[Eclipse] Eclipse Project, http://www.eclipse.org 

[Eclipse_ref] http://www.eclipse.org/articles/using-perspectives/ 

PerspectiveArticle.html 

[EMF] Eclipse Modeling Framework, http://www.eclipse.org/modeling/emf/ 

[Europa] Eclipse Europa project, http://www.eclipse.org/europa/ 

[ECORE] Ed Merks and Dave Steinberg, “From Models to Code with the Eclipse   

  Modeling Framework”, http://www.eclipsecon.org/2005/presentations/ 

  EclipseCon2005_Tutorial11final.pdf 

[OCL] http://www.omg.org/technology/documents/formal/ocl.htm 

[UML2Tools] http://www.eclipse.org/modeling/mdt/?project=uml2#uml2 

 


